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Bum Marketing Mind Set Volume 1 

Niche Factors That Never Fail! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

How To Evaluate A Niche For Profitability. 

How To Really Pick Clickbank, CJ and Other Affiliate Products. 

Travis Sago 

http://www.bummarketingmethod.com/ 

Give me a hungry crowd that will open their wallets! That’s all I want. 

Since 2006 I have built a business that does $1,000’s every day. And I did it starting from scratch because I have 

become an expert at finding hungry crowds. And now I am going to teach you. 

Yes…product selection matters…Yes…copy and salesmanship matter too. However, DEMAND TRUMPS 

EVERYTHING! Are you a horrible salesperson? It’s okay! Take a trip to the desert and come across a thirsty mob of 

people and you have a gallon of ice water…How good of a salesperson do you have to be?  

So how do you evaluate a group of people and determine how hungry they are? 

Niche Factor 1 (Mind Share) 

How many times a day does a person in this niche think about___________. 

You will never have an exact number per se…but, is it something that a person thinks about once a month, once a 

week, once a day, or…once a day or more. 

Obviously, the more they think about _________ the more prevalent a problem or want. This is one of the most telling 

of the niche factors because it incorporates so much of human nature.  

Examples: 

Guys that want to date more. (What do you guys think about 13 times a day?) 

Pregnant Women ( Do you think they think about their baby more than once a day?) 

People Behind On Their Bills (Every time the phone rings!) 

People About To Get Married 

Couples About to Divorce 

First Time Home Buyers 

Parents With ADD Children 

See how all of those people will think about their situations and problems once or more per day? When you think 

about something often…it is important to you. 

Contrast this with these examples: 

 

People interested in origami 

People that want recipes 

http://www.bummarketingmethod.com/
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People with weeds in the yard 

People interested in hypnosis 

People with poor vocabularies 

People with poor memory 

See how those are things that people might think about occasionally? If your selling a book on how to improve your 

memory…you will want to find a crowd that is affected by this problem EVERY DAY! Perhaps a college student or a 

grad student…or a professional salesperson that just can’t remember names. 

Niche Factor 2 (Take Their Emotional Temperature) 

Now this can be done in most cases with some common sense. What we want to do is gauge how strongly a 

person feels about _____________. 

The more emotional the person the more motivated they will tend to be. Niche Factor 1 and 2 typically will go hand 

in hand. 

People that think about something many times a day are typically emotional about the subject. But, this is not 

ALWAYS the case and why I always take the “emotional temperature”. (I brush my teeth 2 times a day, but have 

little emotion about it.) 

If you are new to a niche and “can’t read the thermometer” you will want to go and “hang out” with the niche. The 

easiest way online is to hang out at the same forums they hang out on. 

Here’s how I do it. I just go to Google and type in, niche +forum, if you have a hard time finding a forum see Niche 

Factor 3. 

Niche Factor 3 (Do They Want To Talk About It?) 

When people are passionate they TALK ABOUT IT! The obvious place online is on forums and discussion groups. 

When I am evaluating a niche, A BIG RED FLAG goes up if I can not find a couple ACTIVE forums dedicated to the 

niche I want to serve. 

Now sometimes, it is just because the niche doesn’t lend itself to “online forums and chat”. A good example would 

be when I was looking at people that collect Antique Tractors. There are a few forums, but not many…but not 

because of a lack of passion, but because old farmer dudes just don’t hang out online much. (Which is also good to 

know before you dive in to a niche.) 

You can also check out places like www.meetup.com where people form groups so they can meet at locations and 

discuss their common passions and problems. 

I would also recommend going to http://answers.yahoo.com/ 

Now if you find questions asked that is a good sign, but if you don’t find any that is NOT necessarily bad because 

not everyone goes to yahoo to find answers to their problems or questions. Make Sense? 

Niche Factor 4 (Cost Of Entry!) 

How much does it cost to be a part of ______________? Golf immediately comes to mind. If you are going to be a 

golfer…you are going to fork out the dough! That is why so many internet marketers are after the golfers. They 

have all 4 Niche Factors that we have discussed. 

 

 

continued from page 1 

http://www.meetup.com/
http://answers.yahoo.com/
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You can be willing to bet that if someone has paid a lot of money …or it will cost him a lot of money if they make a 

mistake… they are part of a hungry crowd. 

Let’s look at a few examples: 

Remote Control Airplane Enthusiasts ($300+ every time they total a plane?) 

Yacht Owners (astronomical $$$) 

Golfers (sometimes in the $1000’s just for Country Club Memberships) 

Home Schoolers (a bundle for books and courses) 

Home Buyer 

See how that works? Give me a choice between a jogger who just needs a pair of running shoes or a golfer and I will 

take the golfer any day based on Niche Factor 4. 

Niche Factor 5 (Who Else Wants Some?) 

Are there other marketers paying to get traffic from ____________? This is likely one you have heard before. 

UNFORTUNATELY, this is about all some “marketers” do. This is PART of the recipe, not the whole enchilada. 

Go to Google and type in a few key phrases that people in your niche would type in and see if there are other 

marketers advertising. Also look and see if there are one or MORE affiliates in the marketplace. If you see multiple 

affiliates on one page THAT is a terrific sign that your crowd is hungry and is buying like CRAZY. 

 

Does that mean…that you can just take out an ad and make big money? NO!...but it does mean that if you do a little 

homework…and the other niche factors are in place…you won’t have a problem finding hungry customers. 

Niche Factor 6 (What is their disposition?) 

This is where you play Devil’s Advocate and it is VITALLY important. Why wouldn’t __________niche buy _______? 

And then look at your answers and see if they are something you can overcome. 

Here’s two very common examples: 

Niche will defer to a higher, or more credible authority. This happens all the time and I don’t like to mess with it. 

This is common with medical ailments such as people with Sleep Apnea or Arthritis…etc… 

http://www.google.com/
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You have to become credible or they are just going to talk with their doctor. They are not looking to “buy a cure” that is 

not their disposition. They are pure information seekers…and will defer to their doctor. 

Another good example is the “tattoo niche”. Thousands perhaps millions are being lost by marketers that don’t 

understand that these folks are going to defer to their local tattoo shop and friends….and then the marketers get hit 

with the double whammy… 

They just want free info! Depending on the niche, you may be able to get them to opt in and give them what they 

want, Free INFO. If you can educate and build a relationship, many times you can go on to make sales and build a 

business.  

The key questions are  

What do they want? 

And is there a person, place or thing that would IMMEDIATELY pop into their mind as a source? And if 

so…Are you selling it?...Can You Sell it? 

Because, if you are not selling it, you have to overcome it…or look at that as a “big red flag” 

This is CRITICALLY IMPORTANT! Let me give you another example that I see almost every week helping folks get 

started with Bum Marketing and Affiliate Marketing. 

Acne Market…The niche could be adult acne sufferers…which have traits from the big 3, Niche Factors 1 & 2 and 

while there is no acne forum that I have found, there is a lot of questions asked which is Niche Factor 3. There is a 

positive Niche Factor 5…but Niche Factor 6 is where it all goes to hell in a hand basket for a lot of marketers. 

Why? 

Because they are not paying attention to what the crowd wants. If they would have asked… 

Why wouldn’t Adult Acne Sufferers buy an acne ebook? 

Answer: Because they want a cream, ointment or pill! And they see Jessica Simpson everyday telling them how great 

ProActiv works! Because people want “instant fixes”…and on and on… 

Does that mean you can’t sell acne ebooks? No, you can, you just have to find a crowd that is predisposed to buying 

your ebook… 

For example adult acne sufferers that want a natural remedy. 

BUT! Let me ask you? When the crowd is SO MUCH BIGGER for the creams, ointments and pills…why not go where 

the larger DEMAND resides? 

Now…let me give you a very powerful tool even though it is a little beyond the scope of this report.  

If you know they have an objection DEAL WITH IT! Or you better make sure the merchant deals with it. Now the tool is 

HOW YOU DEAL WITH IT. 

Use the tried and true FEEL, FELT, FOUND method. 

Which works like this: 

Let’s say you are selling a book on “how to repair your credit” and you know that one of your prospects MAJOR 

objections is that they can find it online for free…Okay?...so in walks your 3 friends  FEEL, FELT, FOUND… 

I understand how you feel 

I felt the same way. 

But what I found was… 
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“…You have probably searched all over Google and are gathering as much free info as you can. I totally understand 

how you feel because we need to be as thrifty as ever. I felt the same way, I was on a serious budget and would 

rather spend my time rather than my money on finding the credit repair info I needed. But what I found was there was 

so much conflicting information! I was fearful that some of that information would actually damage my credit and make 

matters worse. I didn’t even know where some of the information was coming from? That’s why I decided that $19 

would give me peace of mind knowing that Al Sharpton’s 19 years of experience went into the Attorney’s Credit Repair 

Guide. I just wanted information I could trust.” 

Does Feel, Felt, Found always work? No, but dozens and dozens of times I have turned a loser into a winner by using 

my 3 friends Feel, Felt & Found. The magic works because you are telling a little mini-story that relates with the 

reader. 

How To Get The Most From Niche Factors That Never Fail 

 

First, unlearn old habits. You don’t pick Clickbank products by gravity. How many searches something gets is no 

guarantee that niche will buy. So, put away the keyword tools for evaluating your niche. Keyword tools find keywords. 

They can give us niche ideas…but they are a horrible evaluation tool. 

Let’s say you are at Clickbank trying to generate niche ideas. When you look at a product…the FIRST THING YOU 

DO…ALWAYS…is match the product to a group of PEOPLE. 

Some will be readily apparent…some will not. 

So, if you are looking at How To Eliminate Your Golf Slice, that is pretty easy to match to golfers. Can we make further 

matches?...Golfers that slice?  

Then…take it through the 6 Niche Factors That Never Fail…we might even want to make further distinctions as we go 

through the factors. For example: 

Who would think about their slice more often (mind share)? A recreational golfer?…or a pro golfer? Or somebody that 

wants to go pro?...see how it works? 

NOW…WE CAN MAKE DISTINCTIONS on what products we pick. If we are targeting pro or semi-pro golfers…we 

don’t want to pick a product that is geared for beginners when we are targeting professionals. 

STOP LAUGHING! It happens all the time. We get sold this bill of goods about picking the products with the HIGHEST 

GRAVITY and forget that it is ALL ABOUT THE PEOPLE. 

Still laughing? Here is a live example: This guy is advertising on “How To Make Money Online”, very expensive (at 

least $1.50 per CLICK)…AND what does he show his visitors? 

 

Do you see a problem? His navigation bar has terms like Affiliate Marketing, Google 

Adsense, Adwords Confessions, and  Affiliate Project X. If I am a person that types in 

“how to make money online”, what is my disposition?...am I new, intermediate or 

advanced? 

I am new to all of this!...and let me tell you…the second I see Affiliate Project X…I hit 

my back button because I think this is some alien, project 51 site. I have never even 

heard the term affiliate marketing or adsense. 

Now, if instead of “affiliate marketing” I saw “sell other people’s products” I might hang 

around. 

But what I REALLY want is to explore my OPTIONS. And I would really respond well if 
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someone were to say “I am going to show you the 10 most popular ways everyday people are earning spare cash on 

the internet.” Just give me your name and email and I will rush you your free report. 

And then the marketer…if he/she is smart is going to pick a product THAT MATCHES the mindset. So, a sales page 

from Rosalind Gardner that is a story of an everyday gal that made money selling other people’s stuff is going to 

inspire me more than reading some nerd’s cryptic sales page pimping something called Affiliate Project X. 

So far, we have looked at a product and matched it to a group of people. If we have a hard time matching it to a group 

of people…we either need to research and find a crowd that has a majority of the Niche Factors or PASS and go on to 

another one. 

I really want you to get this so, our thought process might go something like this: 

Hmmm product Z looks interesting. Who would have a problem that they think about once or more per day that would 

benefit from this product? (Niche Factor 1 - Mind Share) 

Once you have a group in mind, then run it thru the other Niche Factors. 

(emotional?) 

(Do they want to talk about it?) 

(Cost of Entry?) 

(Competition Level?) 

(Disposition) 

So Let’s run this through a real example: 

On Clickbank there is this popular product: 

 

What they do is essentially allow you to plug in a phone number and tell you who 

owns it. 

So our FIRST STEP is to match this product to a hungry crowd. Who would be 

DESPERATE to know who owns the phone number that is on the caller id or cell 

phone? Maybe someone else’s cell even? 

Who would be thinking about this once a day or MORE? How about a wife or girlfriend that suspects their old man has 

a cheating heart? I bet if they see a strange number come up often…that they would think about this DOZENS of 

times a day…It would drive them bonkers not knowing! 

So we have Niche Factor 1 (Mind Share)…right? 

Do we have Niche Factor 2 (Emotional Temperature)? A high level of emotion? Undoubtedly! 

How about Niche Factor 3 (Talk)? Two minutes of research…say HECK YES. There are forums, websites and yahoo 

answers is full of “cheating husband”…”cheating boyfriend” conversations, questions. (at this point I start to get 

excited!) 

Niche Factor 4-Cost of Entry? This one is tricky because it is not a dollar amount. But a relationship is an emotional 

investment. And yes, these women feel a large EMOTIONAL investment. Positive Niche Factor 4. 

Any advertisers targeting this crowd? Niche Factor 5? What I am going to do, is go to Google and type one or two of 

the biggest questions this crowd may have. 

Namely, “Is my husband/boyfriend cheating?” and something like “find name of cell number”…both of those ARE 

PACKED with Adword’s advertisers!...So we have very positive Niche Factor 5! 
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Niche Factor 6 (Dispostion)- This one, in my mind is fairly easy. Jane suspects Tom of cheating. Jane finds odd phone 

number on Tom’s phone and it shows up several times a day! Jane will be crazy until she finds out who owns the 

number!...and she can’t just ask and BELIEVE Tom’s answer can she? 

Will Jane spend $19 to find out instantly who owns that Cell Number? 

Chances are very good! 

So, right now there is NO DOUBT in my mind that if I target these gals, I WILL make sales. Now, if I can find a service 

that “matches” the crowd better…I will do even better. These ladies will buy! 

After all…this report is the Niche Factors That Never Fail, which brings me to one last, UBER IMPORTANT point. 

 

“The Magic Is In The Niche – Not The Product!” 
 

Let’s use our example above. You could probably make a living FOR THE REST OF YOUR LIFE selling to these 

women. They have all 6 Niche Factors! There are MULTIPLE ways and multiple products you can sell to them. And 

there are ALWAYS going to be guys and gals that cheat on each other UNTIL THE END OF TIME. And guys and gals 

that desperately want to know about it. And then they will want to know what to do…once they know! 

In fact, a little digging, shows all kinds of products are thriving in the marketplace catering to this very hungry crowd. In 

fact…that could even be a Niche Factor 7? 

There is ZERO doubt in my mind that if you put a little guide together or had someone put a little guide together along 

the lines of “7 Signs Of A Cheating Man” and asked for a name and email. Put up a one page website and drove traffic 

to it…that it wouldn’t be long before you were making a SUBSTANSIAL INCOME that could replace what most people 

make working 8-12 hours a day. 

 

What You Need To Do Now 

If you just read this report and do nothing. That is exactly what is going to happen…NOTHING. Here is an exercise I 

want you to do…to build your Niche Factor muscles okay? 

As you go about your day…there are literally niche ideas everywhere you turn. I want you to start looking at something 

and matching it to a group of people…any group of people at first. 

If you see a lamp…you could match that to “avid readers” “teenagers with acne” “people that like moths” “people with 

new homes” etc…etc… 

(This is a great exercise to do when shopping at Wal-Mart) 

Just practice “brainstorming matches” at first… 

Then I want you to MEMORIZE the 6 Niche Factors because now you are going to start running them thru your mind 

as you go about your day. 

If you see a billboard for an iPhone…match it to a group of people and then run it thru the 6 Niche Factors as best as 

you can even though you may not have access to the internet. 

You need to develop the Niche Factor muscle. And it will be hard at first…but the more you do it…just like learning 

anything, the better you will get! I promise! 

If you practice this skill, it can take care of you in style for the rest of your life. 



 

Page   8 

Once you feel like you have your “sea legs” then give it a go at Clickbank or CJ or what MAY happen, which would be 

even BETTER, is in your “practice” you will find a hungry crowd while you are doing your shopping or sitting in traffic. 

For Die Hard Skeptics 

I hear some of you old salts screaming right now! What about this? What about that? What about, Is your niche easy 

to reach?...You didn’t cover that one Travis! 

Sure I did… 

It is built in to the Niche Factors That Never Fail! Niche Factor 3 ( Do they want to talk about it?) covers it beautifully! If 

there are several active forums or places they gather to talk…you can reach them! 

See? 

This is not some “theory” I dreamed up…I promise. This is my process I have developed over the last few years that 

earns me $1000’s every day…I have shown and taught others that have gone on to build business that earn 6 figures. 

Several have quit their jobs. More importantly, to me, is hundreds of guys and gals have made their FIRST MONEY 

online and generate extra income in their spare time. (Not everyone wants to own a business.) 

And I am not saying this because I feel I need to prove myself. 

I am saying it because…I want you to feel confident that… 

If you are struggling or just not at the level you would like, Niche Factors That Never Fail is just that! If you have a 

hungry crowd that has all of the 6 Niche Factors then I guarantee that niche is BUYING. Does that mean YOU will 

never fail? No…because if you have a hungry crowd which is the MOST IMPORTANT element in a business, you still 

have to serve them up what they are hungry for…fail to interpret this correctly and you can still flop… 

 

So Stay Tuned For The Next Episode of Bum Marketing Mindset! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

QUESTIONS AND ANSWERS 

Q:   Do I need to have all 6 Niche Factors? 

A:   Yes, If you want to ensure you have a niche that gives 

you the best odds of success.  

Q:   What’s the best way to find hungry crowds? 

A:   Please do the exercises on page 7. There are hungry 

crowds everywhere. 

Q:   What products should I pick? 

A:   You pick people, not products. Match products to 

people.   

Q:   What do I do once I find a hungry crowd or niche?  

A:   Beyond the scope of this report, but you want to find 

what they are hungry for…and then GIVE IT TO THEM. 

There are numerous ways to reach a crowd. One way is 

free at http://www.bummarketingmethod.com  

Q:   How can I reach you? 

A:   travis@bummarketingmethod.com I’d love to hear 

from you and do my best to answer all the mail I can 

personally. 

Q: Where can I send compliments? 

A: travis@bummarketingmethod.com 

Q: Where can I tell you how much you suck? 

A: trashcan@bummarketingmethod.com 

 

 

 

http://www.bummarketingmethod.com/
mailto:travis@bummarketingmethod.com
mailto:travis@bummarketingmethod.com
mailto:trashcan@bummarketingmethod.com
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Notes: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Page   10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

M O R E  W A Y S  T O  C U S T O M I Z E  T H I S  

T E M P L A T E  

FOOTERS 

To change the text at the very bottom of each page of your 

newsletter, click Headers and Footers on the View menu. 

Use the Header and Footer toolbar to open the footer, and 

replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 

article to let the reader know that the article is finished and 

will not continue onto another page. Position your cursor at 

the end of the article, click Symbol on the Insert menu, 

choose the symbol you want, and then click Insert. 

BORDERS 

You can use page borders and text box borders to change 

the appearance of your newsletter. Borders on text boxes 

help keep different articles separate, and can set off sidebar 

articles from the rest of the page. To change a text box 

border, select it, double click its edge and choose the Colors 

and Lines tab in the Format Auto Shape dialog box. 

Inserting and Editing 

Pictures 

Type your sub-heading here 

You can replace the pictures in this template with your 

company’s art. Select the picture you want to replace, 

point to Picture in the Insert menu, and click From File. 

Choose a new picture and then click Insert. Select the 

Link to File box if you don’t want to embed the art in 

the newsletter. This is a good idea if you need to 

minimize your file size; embedding a picture adds 

significantly to the size of the file. 

To edit a picture, click on it to activate the Picture 

toolbar. You can use this toolbar to adjust brightness 

and contrast,  

Choose a new picture, and click the Link to File 

box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more 

detailed editing, double-click on the graphic to activate 

the drawing layer.  

QUESTIONS AND ANSWERS 

Q:   I would like to change some of the text box shading to 

improve the print quality. Can that be done? 

A:   Yes. To change the shading or color of a text box, 

select it and double click its borders to open the Format 

Text Box dialog box. Click the colors and lines tab and then 

choose the new color from the Color drop-down list in the 

Fill section. 

Q:   What’s the best way to print this newsletter? 

A:   Print page 2 on the back of page 1.Fold in half and mail 

with or without an envelope. For best results, use a 

medium to heavyweight paper. If you’re mailing without an 

envelope, seal with a label. 

Q:   I would like to use my own clip art. How do I change 

the art without changing the design? 

A:   To change a picture, click on the picture, then point to 

Picture on the Insert menu and click From File. Choose a 

new picture, and click Insert.   

Q:   How do I change the text and borders that appear at the 

bottom of every page? 

A:   Click Headers and Footers on the View menu. Use the 

Header and Footer toolbar to navigate among headers and 

footers, insert date or time, or format the page numbers. To 

change the text in the footer, select it and type your new text. 

To change the border, click Borders and Shading on the 

Format menu. 

Q:   Can I save a customized newsletter as a template for 

future editions? 

A:   Yes. First make any changes you want to this newsletter, 

then click Save As on the File menu. Choose Document 

Template from the Save as type drop down list (the 

extension should change from .doc to .dot). Save the file 

under a new name. Next time you want to create a 

newsletter, choose New from the File menu, then choose 

your template. 
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